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Discovery StudioldZ S A4 7> b-4—N—FRKDOV I ;U 27 TF. AFT[EWindowshRDDiscovery StudioZZMEHRLTEYET. CHAEH
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CAVNROBEY =Yy AOKRED T —EH
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1.4.3=-a7)L

Windowshiz Discovery StudiolC~NJLTHH Y £
Discovery Studiof2&if& (C A =2 —/\—® [Helpl — [Help Topics] #&EIRT 2L TSV HMNEEIL. NLTEEI,IRRINET.

Window | Help

Help Topics
Getting Started

Tk YU RARA >4 %BERLEICEL & ZOEBOHRELHANRRINET.
ZDFRADOTERD [Click here forhelpl 29U v 42 L ZDEBICEHTA2NLVTEENRREINET .

Run Simulations

These tools work on a single molecule or complex. To

minimize a set of small molecules independently, use
Minimize Ligands.

Tools

Calculate Enerey...

=i Clean Geome
T Calculate Enerey

Minimization...

m Calculates single point enerey and estimates
entropy using CHARMm. Requires a molecule in the
Use Standard Dyr{ current window. To process multiple molecules or
equilibrate and pe| specify specific parameters, open the Enerey
run, which can be | Protocol.

NAMD.
) Click here for help
Standard Dynami
Dynamics (Production)... (
- R kS

HA47050 [Helpl 20U v I $2TLETHENNTHERERRT D ENTEET.

Calculate Energ

Parameter Name Parameter Value

Input Typed Molecule laql:laql
Implicit Solvent Model None
Nonbond List Radius 14.0

Electrostatics Automatic

Estimate Entropy False

| Show Parameter Help

[ Run ] [Optionsv ] [ Cancel ] [ Help
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2. (FAR”E

fio

BA7 V=2 a>yOZFRMAICKEL. S A0FAFRERFTTEYET. S1EYREHRELARVLS CHNCES L.
SAEYADLEE - RBEFBAEEELLIBE. FERCSA1 Y RFAEELTEAHY ET.
FHAICOWTIS MY RADFIRADS 1 2> RHOFIRICOVWTEISEEE L.

=ZR

fio

AR=IOARY FSAVHITR. LTORLEEFERBLET.
login]$: v 54>/ —k

[FNnN]$ - 5tE/ — I

[login/rNnN]$: O &1 >/ — RERIFEHE, —

[yourPCI$: B &' 1 >/ — FADIEGTIRIE

2.1. Discovery Studio Client® #Z&]
WindowsIZ 1 > & b—JL L f=Discovery Studio ClientZ#2&]L £
Windows 10 Oi5&
[R%&— k1 — [BIOVIA] — [Discovery Studio</\—Y 3> &> #Uv I LET.

EEEEEIX2017R2DBDTT .

File Edit View Chemistry Structure Seguence Chart Scripts Tools Window Help

Mocromoiccuics Y Recepto

“new B RE * X 22 B B | % | [5 Display Sty!

nd Interactions | Pharmacophores | Small Molecules | X-ray My Tools
le. v: Q¥
Tools B | Files | [~ DS Welcome

Run Simulations >

These tools work on a single molecule or complex. To I Dic S 2

minmize 8 et of cnall molectes ndependerty, use DS BIOVIA | Discovery Studio 2017R2
inimize Ligands

Tools

Galculate Enerey

Corecsren

Minimization
\ ] \ y.
+ - Vi - .
Use Standard Dynamics Cascade to minimize, equilibrate Actions SR Data Notifications
and perform an initial dynamics production run, which can be
continued using either CHARMm or NAMD.
Standard Dynamics Cascade
Dynamics (Production) My Recent Actions Sample Files My Recent Jobs
amics (NAMD)
» Minimization » Protein Structure » Standard Dynamics Cascade
e » Calculate Energy... » Multiple sequence alignment 0Oct-23 16:06
ynamics (Heating or Gooling) o a " Calculate €
» Open. * Annotated sequence * Calculate Energy
» Standard Dynamics Cascade » Pharmacophore model 0Oct-23 16:06
» Structure based pharmacophore » Calculate Energy
My Recent Tool Panels
* Ligand structure Oct-23 16:06
rec ar Dynamics * Run Simulations * Small molecule library * Minimization
Oalculale Free Enerey from Steering Forces.. » View Interactions » Receptor-ligand complex Error Oct-20 17:27
fom | > Bacteriorhodopsin trajectory > Celculate Energy

Calculate Enerey (DFT) -
Calculate Enere:
Minimization (QM-MM)

Oct-23 16:06

My Recent Files )
» Minimization

* charmm.log Error Oct-20 17:29
Setup Onns(ralr\ls » Output.log » Minimization
Change Forcefield
- » lagl.dsv Error Oct-2017:29
PAnalyze Trajectory
» 1aql.pdb » Calculate Energy
Galculate Electrostatics 0ct-23 16:06

Server: <none>

#¥TT21HEF [Filel - TExit] ZERLTLEE W,

- 6/28 -
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2.2 H—IN\—~DIEHELTE

HEEITIROICIEK. SFEERTTI2H—NORENMVEICRY ET. ZEE Y—I/X\—h»5 [Filel » [Change Server] #3EIRL. XD E A
7S ETITOET.

- TSUBAMEQH—N\—%FIHT 5155
Discovery StudioDstE #TSUBAMETREITT B L IEFTE EH Ao

*PCLTHEZITOHBE
Server nametf(C [Nocalhost:9943] #AJ1L. OKR 4> %#IRL £¥ . Discovery Studio Server f > & k —JLF|EICE LN THTTPS PORTIZ9943L
HOFEERELTWSIBEIE. 99430 EE2LBA T EEL.

BRER XOBEBROE SIS BEATICRELEATIR RSN TONE ELIRESATVET.

Server:localhost:9943- v17.2.0.16349

23. 4> REMA’

KR DRERR
TSUBAMEICR &' A > LTZIREET. RDaxy RICkY. SA ey RFBRREEETEET.

[login]$ lmutil Imstat -S msi —c *****@kvm5, *****@kvm6, *****@1ldap2

o

R—FESET7TY 5 —2 3 > EME(TSUBAMEL) CEEARICSIBATRETT .
/apps/t4/rhel9/isv/materialsstudio/t4-license
R— FESIEBFIAPEEEEINET.

Discovery StudioZ#2&] L TL\ 3 Windowsh D iR T ENTE X T

LET.

i
i

AB—FAzZa—HbB FTARTOTAOS S A >BIOVIA > Licensing > License Administrator X.X.X > Utilities (FLEXIm LMTOOLs) #
[Service/License File] 4 7#%#Bi=. [Configulation using License File] #ZRL £7 .

MSI_LICENSE_FILE £ RIRENTWSHZ L #HERRLE T

- 7128 - 2025-01-31
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LMTOOLS by Flexera Software LLC

(o]

File Edit Mode Help

€ nse System Settings | Utiktias
Normaty the bcense fie is sready specited.

!

Stop/Reresd | Switch Report Log | Server Status | Servar Disgs | Eorrowing l
o override it setit here .

r License File

(¢ Confguration using License Fie
(" Confguration using Servces

lmnss_ms

[T LMTOOLS ignores cense fie path environment varisbles

[Server Status] 2 7B &. [Perform Status Enqurity] #2 Vv 235 & SA &2 RDFBRAARREINET.

BEDSAtEY ADHERTLIEVWESIE. [Individual Feature] CRRLI=EWS A REZEATILT

o=

[Perform Status Enqurity] #21TL £
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3.1. HK

Discovery Studio®##{E &3~ TVisualizer Discovery Studio Client ET{TLET .

-

Discovery Studio Client

=)

File Edit View Chemistry Structure Seguence Chart Scripts Tools Window Help

Tools [ Files R ~ | DS Welcome | % 1aql [

Run Simulations “l | o @@ <Cell>

4 [V]g* laql

These tools work on a sinele molecule or complex.
To minimize a set of small molecules

independently, use Minimize Ligands. Jes A

sjes <chan>
Calculate Energy.. Ve W

t+# Glean Geometry 7|9 Hetatm

V]9 Water
v| %, Protein Groups
V| % Ligand Groups

Minimization..

Use Standard Dynamics Cascade to minimize,
equilibrate and perform an initial dynamics
production run, which can be continued using
either GHARMm or NAMD.

Standard Dynamics Cascade..
Dynamics (Production)...
Dynamics (NAMD)..
Advanced

m

Dynamics (Heating or Cooling)...
Dynamics {Equilibration)...
Solvation...

Steered Molecular Dynamics

Create Pulling Atom Pair

Steered Molecular Dynamics...

Calculate Free Energy from Steering Forces..

A

m »

Receptor-Ligand Interactions | Pharmacophores | Small Molecules m My Tools
%

GNew "B REH ® & @ |8 Display Style.. ~ Non-bond Interactions...

Galculate Enerey (DFT).. Fy Index  Name  Visble  Tagged PartialChargeMethod UseResidueTer|
Caleulate Enerey (QM-MM).. 11 lagl V| Yes No MomanyRone True
Minimization (QM-MM)... 4+
Setup Constraints . = 3
Chanee Forcefield ¥ = = - - s s s
——— ~ | \_Molecule /\_Cell /\_AminoAcidChain /\_AminoAcid /\_Atom /\_Chain /\_Residue /\_Group /\_Bond /
Jobs [ n
Protocol Name Saved Status Details Elapsed Time  Start Date at-
Calculate Energy No Success -1816.61966 kca 0:00:13 B 10 23 17:08:0 localhost:9943
Minimization No Success -20943.30624 kc 0:00:39 £ 10 20 17:35:3 login0:9943
Calculate Energy No System Error | starting job C9D £ 10 20 17:35:0 login0:9943 i

Server:localhost:9943M v17.2.0.16349

FHRIFEANLTOUTOR—VETEL SV,
Working with Discovery Studio > Working with the client > About the client

3.2. REDHERER UEE

[Edit] — [Preferences] 22 Y v L%d.

-9/28 -
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Preferences™ 1« > RUNIIE LAY ET.

4
=

Undo
Redo

Cut

Copy

Paste

Paste Special...

Delete

Select All
Select...

Invert Selection
Group...

Find...

Add Attribute...
Attributes...

Preferences...

Ctrl+Z
Ctrl+Y

Ctrl+X
Ctrl+C
Ctrl+Vv

Del

Ctrl+A
Ctrl+E

Ctrl+F

File [Edit] View Chemistry Structure S

3

Dvhamice TEauilBrationy .

[Molecule Windowl — [Graphics] Z&RL %7

- 10/28 -
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- __
Preferences

> General a [Molecule Window
> Files Explorer Note: These preferences change the global settings for the application.
4 Molecule Window To change the settings for your current window use the Display Style dialoe.
Default Layouts
Graphics Projection Quality
Data Table () Orthoeraphic ) Low
Display Styles @ Perspective ) Medium
Lightin i
'ghting 20000 4 ® High
Materials
Stereo ) Ultra-high
> Import Backeround Color, Image
Export _ Line width: 160 |2
Sketch and Clean
guelry Hardware acceleration Rendetuielonlmeve
00ls p - o
o L "] Uge OpenGL Shaders ) Simplified
> Dreiding Minimize
> Sequence Window (] Use fast refresh ® Fast
> Annotation Window LREs e @ Eull
. Charts | Depth cue -
Protocols
Text Window
» Validate Protein Struct . [ Encat ] [ Help ]
< | 1 | »
QK ][ Cancel ][ Apply ]

[Protocols] Tlk. 7B b ALEITORHDEEEITVET. HIZIE
LETHFICTI A LI —BPRFEBMEZEETEET. Fxzv IRy I REHSIRVIEE.

E 3

-11/28 -
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-
Preferences

> Import - [Protocols
Export
Sketch and Clean Number of jobs to display 32,000
Query Maximum size for automatically downloading results {(MBE)
Tools [] Close protocal tab on run
» Dreiding Minimize

Use default path to save a job

> Sequence Window —
(] Save password

> Annotation Window

Charts [] Save intermediate files when running protocols
Protocols Server names list containg 10 5 items
Text Window Pipeline Pilot Client Setting

> Validate Protein Struct Path to the Pipeline Pilot client used to view protocols

Build and Edit Nucleic |- OVIA¥Pipeline Pilot Glient 2017 R2¥bin¥Pipeline Pilotexe

> Protein Utilities
Superimpose Proteins
Dendrogram Window

» Evolutionary Trace
Forcefield
Phylogenetics
Ligand Definition

» Define and Edit Bindin

Protein Docking . [ Resst || Hep |
P - -

[ QK ] [ Cancel ] [ Apply ]

3.3. Toolbars D% FE K UNFEER

ToolbarsMEZTE - EEREITLET. [Viewl — [Toolbars] Z&RT 2 L. EHICAZa—NRRINET. ‘RSN AZ2a—OFTFzv s
BASTVUDREDNIRERTINTVNEHDTY . Kk - IRTRIFENETNOEEERI Y Y ITHILTITAET.

-12/28 - 2025-01-31



Chemistry Structure Sequence Chart Scripts Tools Window H

¢ [ Display Style... Ctrl+D W
" Color... *,{,\ Display Style.. Non-bond Intet
Transform » PS Welcome % 1aql £
3 Spin »
L
;‘ Storyboard »
| Clipping Planes...
1 Sterec
§ Tile Molecules in View Ctrl+L
i 2 Full Screen Fi1
: Visibility >
:J v Graphics Ctrl+G
: Hierarchy Ctrl+H
1 v Data Table Ctri+T
N
| Explorers »
. Docks »
: Toolbars » Alignment
l Tool Panels Animation
he Atom Fﬂ Atom Colors
ecular Dynamics.. Atom Display
‘ee Energy from Steering Forces... Chemistry
Dendrogram
:Z::; Eg:nnMM) Search Product Features L
) (OM-MM)_. ; Navigation ]
aints Nucleic Acid Structure Display [
sfield * Protein Structure Display
Elany v Protocols
ctrostatics | @ Query i
Scripting |
me Saved Status Sequence l
e Energy No Success Sketching D
ation No Success v Smart Tools 0
v Standard |
— View
T
v’ Status Bar

- 13/28 -
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B4 MEE T+ LA —DFETE

STEIER &, #IEREETE T & My Document > Discovery Studio > Results A TN ICIER SN ET. RELE T+ ILE—2EE L WFEIE. Files Explorer
TEEEITLWET.

5l Z 1E. My Documents 7 # LA —[CHT3R 7 + L&A — [Sample! Z{ERF 5158+ Files Explorerd®My DocumentsZEIRLT. G2 Y v I LET.
KRENB A=a—DNew Folder&BIRL £ 7

Fies 3 ;

& My Documents

> (&) Deskt Remove Root
> W Samp Set as Default
’ Windo Refresh F5
b £ T3_HS B
> & share Open With y
> k= smbo
> &) Histor] 2€ Cut Ctrl+X
Ff Ccopy Ctrl+C
[ Paste Ctrl+V

New Folder...

72X Delete Del
Rename F2
Properties...

My Documents 7 # LA —Z R L. Sample7 # LA —%BIRL. AV Vv ILET. RREINBA=a2—0DSetas Default ZBRLET. Th
T. Discovery Studio TERITL &R DRIFIHLASample 7 # LA —IC78Y E£F .

> () report

> ) SGE

Add Root Node...

Set as Default
Rofrach =1

FIANMD T A NE—ICRESNIETHNLEA—TAAVDEEENEICRYET.

- 14/28 - 2025-01-31
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4.1 B FDIEE

A=a—/\— [File] - [New] — [Molecule Window] %#3ZIRL. ¥R IcMolecule Window%R &£ ¥ .

L e e
File | Edit View Chemistry Structure Sequence Chart Scripts

New » | 4% Molecule Window

Run Simulations -~

These tools work on a single molecule or complex.
To minimize a set of small molecules
independently, use Minimize Ligands.

Calculate

Clean Geometry
Minimization

Use Standard Dynamics Cascade to minimize,
equilibrate and perform an initial dynamics
production run, which can be continued using
either CHARMm or NAMD.

ndard Dynamics Cascade

Dynamics (Heating or Gooling)

>

s (Equilibration

ation

Steered Molecular Dynamics

z Atom Pair

Steered Molecular Dynamics

Calculate Free Energy from Steering Forces...

Calculate Enerey (DFT)..
(QM-MM)
on (QM-MM)

Setup Constraints

Calcu

Mini

Change Forcefield
Analyze Trajectory

Calculate Electrostatics X
Jobs [
Protocol Name Saved Status Details Elapsed Time  Start Date Server Location
Calculate Energy No Success -1816.61966 kca 0:00:13 B 10 23 17:08:0 localhost: 9943
Minimization No Success -20943.30624 kc 0:00:39 £ 10 20 17:35:3 login0:9943

& Open... Ctrl+0 | we  protein Sequence Window .
| @ Open URL... a1e Nucleotide Sequence Window I
r Discovery Studio Client [=] 5 [t
File Edit View Chemistry Structure Seguence Chart Scripts Tools Window Help
[ Mecromolcoulos MR Receptor-Lisand Interactions | Phormacophores | Small Moleoulos | X-ray [ My Tools Q
% New ~ [B é H P ; % Display Style.. +
Tools £ | Files n | | Molecule [ l )

Server:localhost:9943M v17.2.0.16349 I

WMERY — LA Toolbars[CRRENTWRWESIE. [Viewl — [Toolbars] O—EMSBIRL £ 7.
AEITIERDY —ILEFERLET.

* View Tools

Select R RFCHEEFEBIRLET. BRLEEDFEETRRSNET.

+ Sketching Tools

- 15/28 -
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i

Sketch ¥ EFE—o—oHH LFTATEBELET.

>
Chain % : KB £ H5>R F OECFIAL £ 7.

P
Ring & ImBRtEEE & >N FOBEICFIALET.

+ Chemistry tools

Shows/Add Hydrogens ' = : KEEFEFMLET.

Single Bond . Double Bond . Aromatic Bond « Triple Bond HEEBRKXEEELET.
-

Periodic Table EHROFA LM BERTSEFEBIRLET.

Clean Geometry ~ : B % b HIZEE » I ICER L £ 7.

411. ROEL Y DIBER

FlELT RYEYDIEBE. RVEVHLMBPFADEEICOVT. REALET.
RIng7A4a>&s Vv o35 BESOEEBE—NCRYET.

Z\&| T

Z OIKEETMolecule Window EC—EA S Y v I LET. RFEOFEFHLRIREBENMERSINET.

TIANPTREFES LB >TLWETOT. HEKRELZELET.

Select R #FALTETCORBEEFEERLET. Cul+ATHEWTT

-16/28 - 2025-01-31
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AromaticBond® 2 Y v o L %7,

RISKEEFEMMLET. AddHydrogensRE> %Y v I LET. THEUTOLS ICKEREFIREREFICHMLET.

-17/28 - 2025-01-31



Discovery Studio MFANDFE|EF

UETRYE DEBEIFIETTT .

41.2. Ry LV FEEDETIVIBE
B LRV EY ER—RIC. HORFADEBEFEICOWVWT, HBALEYS. KRETIE. 7/ —IL(COHS0H)EHEHRLET.

KERFEEBRLETY .

- 18/28 - 2025-01-31
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Periodic Table 22 U w 4 L& ¥ . ¥ 5 &Change Elementd 4 7RI NRREINDZNDT. 0] #BIRLOKESI YUY ILET.

,
e o R ==

Group
14 0
H | 24 38 44 BA  BA  T7A | He
Li || Be B (] N a F Ne
Na | Meg| 3B 4B 5B 6B 7B 8 1B 2B [ &l |18 || P S |Gl || Ar

Ca | |Sc || Ti Yo Cr  Mn Cu
WBOL
wmﬁllﬂlﬂm

Ac

HEEER
=

F

=2 e el

QK H Cancel H Help ‘

KERFHBRERFICESBEDYET.
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Add HydrogensR&> %4V v o § 5 &, Bl cBERFICKBRFATMENET.
NETTz/—pMERENEL Tz

42. RTF KRDIEE

A=a—/X\—® [Filel - Newl — ['Molecule Windowl %i&iRL. #f#RIcMolecule WindowZFME£ 7.
[Macromolecules] Tool Set#i&{RL. [Tools Explorer] @ [Build and Edit Protein] 24 Vv LTEBLET.

-20/28 - 2025-01-31
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File Edit View Chemistry Structure Sequence

A OHMH (% % L 1 T s R €

N2 2 & TIDO

Macromolecules BTN dGNNEE G BEETT

G BB EH O X2F0 & |

Tools ) | Files [ B [em

| Build and Edit Nucleic Acid 2| | [

Build and Edit Protein 2([]

Build Action: Create/Grow ~
Conformation: Extended ~

Apply Conformation

Ala Are Asn Asp Cys

Glh  Glu Gly His e

leu Lys Met Phe Pro

Ser  Thr Trp Twr Val

Mse Cse O Ptr  Sep

Tpo Tys &b Pca Specify..
Modify Structure

L/D Conversion Cap Termini...

Define Amino Acid...

Create Structure from Sequence

m

Query Online Databases |

Ao . -

Build Action#® Create/Grow. Conformation AExtended& 7> TWBZ & &MEEL £ T
RERTFROVP—I T REANLET. ANNICIE. BEOFENHYET.

1REBRAITEREEMT S
Choose Amino ACidD3XNFRIED T Z/BE I/ Vv /T2 LZDORENEMENET.

CEERTFRV—STIVREANTS
Choose Amino Acid®Specify 22 Vv 42 LU TOEMRICKY £7.

Enter an Amino Acic

[P-Ianine - &
Specify Sequence

@ One Letter Code () Three Letter Name

[ Cancel ][ Help

TNETVYRMHLEREZBIRT 50 THXRIMRY SRCEBANT S ETHELEE LRI E—HETHETHENTEET,
FHHllEHelpE CB S L.

-21/28 - 2025-01-31



Discovery Studio MIFBDF5|E

Macromolecules tools > Macromolecules tool panels > Build and Edit Protein tools > How to use the Build and Edit Protein tools

4.3. T—AR—ZAM 5 DIEBEDOEYIA

Discovery StudioZ#2E T 5PCA A > 4 —F v M ICIEH T X 5188, RCSB PDB ®NCBIIC & Y EETRAMEIN TS 4 > /80 FOEEDIEIE £ 55
AL ENTEET.
[Filel — TOpen URL] %i&RL. OpenURLY 1 ~ kY EHEENL £ T

MDl ICEEL WA Y O EE I OIDE.  [Sitel ICHEUGRZIEEL TOpent s Y v o5 & ZDtEED Molecule WindowsIZRREh
£7.

http://files rcsb ore/download/ 1crm pdb

Generate URL using

ID: lcrn Site: [Default PDB Structures

Qpen ][ Cancel ][ Help

-
| I Discovery Studio Clien

File Edit View Chemistry Structure Seguence Chart Scripts Tools Window Help

R <€ @ax-

A A" Ry Y0 Y@
N2 & TEI

ww Receptor—Ligand Interactions | Pharmacophores | Small Molecules m My Tools QL

4 New v B [ E - P 5 \% Display Style.. ¥ Non-bond Interactions.. v
Tools £ | Files R | tem B
Build and Edit Nucleic Acid 1 4 U@ <Cell> ~
Build and Edit Protein 4 [7]g% 1CRN
Query Online Databases 4 Viea A
Protein Report vl A¢ THR1
9 0 THR2
Protein Report vl A¢ CYS3 E
To visually inspect the properties of a V| s CYS4
protein structure generate a 7] & PROS
Hydrophobicity Plot or a Ramachandran |
Plot. V| A¢ SER6
Prepare Protein < N ILE7
V| ¢ VAL8
Search Sequences by Similarity 7| A¢ ALAS
Alien Sequences and Structures 7| A ARG10
fnalyze Sequences V| A SER11
Analyze Protein Conservation Pattern V| A ASN12
Superimpose Proteins v| ¢ PHE13
Create Homology Models v /:% ASN14
Search Side-Chain Rotamers 7l s VALLS
Minimize and Refine Protein vl ) CYS16
V| ¢ ARG17
Model Antibody V| ,¢ LEU1B
Dock and Analyze Protein Complexes 7] A¢ PRO19
Desien Protein 7] A GLY20 -
Predict Protein Ageregation < m ’

AV

Analyze Transmembrane Proteins

-

Name ID Visible Color Parent Molecule FullName Type PDB Name Insertion Code Hydrophobicity

1 THR1 1 V|Yes O ) 1GRN &Thrl Threonine THR =07

2 THR2 2 V|Yes D A 1GRN AThr2 Threonine THR -07

3 CYs3 3 v|Yes D A 1CGRN ACys3 Cysteine CYS 25

4 CYsé 4 v Yes O ) 1GRN ACysd Cysteine CYS 25

5 _PROS 5 JIYes 1 A 1CRN A:Pro5 Proline  PRO -16 -
< n »

Molecule /\_Cell AminoAcidChain AminoAcid Atom Bond /\_Grouj

Server:localhost:9943M v17.2.0.16349
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BiERY R RRENET. BRRERELTELEWESE. Molecule WindowsD2WERDTHZ U w & L. Display StyleZBIRL Y.  FflE

Y L= %) Display Style.. 5509

Display Stylew « >~ RUAREET.

Protein® 7 &R &. Display style%Solid ribbon/ S Off[CZEEL £ .
Atom#& 7 &R &, LineZEIRL. ApplyES Vv I LET.

BENS A VRRICEEINET.

Macromolecules®Protein Report# 2 Y v 435 & ZOBEICAT 2 ERPIRTINET.
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[~ 1ern Protein Report [£3 a -

Protein Report for 1crn

Basic Information for Molecule 1CRN

Cell Space Group: 4 (P21 B-Unique Choice: 1)
Parameters: 40.96 18.65 22.52 90.0 90.8 90.0
Crystallographic Resolution: 1.50 angstroms
Molecular Weight of Protein: 4730.52

Amino Acid Chain Names: A

Number of Amino Acids: 46

Experimental pH: not reported

Amino Acid Sequence from Available Structure

Chain A
TTCCPSIVAR SNFNVCRLPG TPEAICATYT GCIIIPGATC PGDY

Comparison of actual sequence versus PDB SEQRES records
No missing residues found within chain A

Biomolecule Generation

THE AUTHOR PROVIDED AND/OR PROGRAM

GENERATED ASSEMBLY INFORMATION FOR THE STRUCTUR
IN

THIS ENTRY. THE REMARK MAY ALSO PROVIDE INFORMATIC
ON

BURIED SURFACE AREA.

To generate the biomolecule(s), use Structure/Superimpose/Apply
Transformation Matrix:

BIOMOLECULE: 1

Apply matrix BIOMT_1 to chain(s): A

Discovery Studio RN F5|E

T—AR—ZHBEIF L EBE XIS RBERNICK YIS ShIEBETH Y. KRIHMIMLTLEEA. Tl THYNSENRTVZ2IEGHH

YET. £01=d. FTEZITSAIIC. Add HydrogenT/ARZRZMML Y. THEMZENY RV Y T 2 MIENNETT .
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P

51. 4> N/ BoigEmELETE

COHEITI&. RCSBPDBMSEUE L IzlemDigERE(EEITVET.

=3 lenEMAEET.

Display StyleZLinelcZEL 3

’ | tern (£ ‘
4 [V H <Cell>
4 [7]g* 1CRN

4

Name
THR1
THR2
CY33
CYS4
PROS

AN B W

Jeo A
v/ ¢ THR1
7 ¢ THR2
v A ¢ CYS3
v M CYS4
v| A PROS
7| ¢ SER6
v\ ¢ ILE7
v| ¢ VALS
v| ¢ ALAS
| ¢ ARG10
vl A¢ SER11
vl ¢ ASN12
v| ¢ PHEL3
vl ¢ ASN14
v| ¢ VAL15
vl ¢ CYS16
vl ¢ ARG17
vl ¢ LEU18
J| A¢ PRO19
vl A ¢ GLY20

1D Visible
v|Yes
J|Yes
J|Yes
V| Yes
lYes

s O R —

m

1

Color

100080

I

Parent
f

> > > >

Molecule

1GRN
1GRN
1GRN
1CRN
ICRN

AY

FullName

A:Thrl
#:Thr2
ACysd
ACysd
A:Prob

\ Molecule /\_Cell \_AminoAcidChain _/\_AminoAcid /\_Atom /\_Bond /\_Group

Add hydrogen R&> %4 Uw s LT KEEMFMLET.

-25/28 -

Type
Threonine
Threonine
Cysteine
Cysteine
Proline

PDB Name
THR
THR
CYs
CYsS
PRO

Insertion Code

Hydrophobicity
-07

=07

25

25

-16

-
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l % fom (£ I
4 [V E <Cell> -
4 [7]g~ 1CRN
a4 Ve A
vl A¢ THR1
v ¢ THR2
vl A¢ CYS3
vl A ¢ CYS4
v| A¢ PROS
7| A¢ SER6
| ¢ ILE7
7] M VALS
| A ¢ ALAS
7| ¢ ARG10
7] ¢ SER11
7] A¢ ASN12
7| ,¢ PHE13
7] A¢ ASN14
vl ¢ VALLS
v| A¢ CYS16
| A ¢ ARG17
v| ¢ LEU18
v| ¢ PRO19
vl A GLY20

m

1

Name ID Visible Color Parent Molecule FullName Type PDB Name Insertion Code Hydrophobicity

1 THRI1 1 J|Yes |:| a 1CRN #:Thrl Threonine THR -07

2 THR2 2 V| Yes D A 1CRN A:Thr2 Threonine THR =07

3 CYs3 3 J|Yes D a 1CRN ACysd Cysteine CYS 25

4 CYS4 4 7| Yes ] & ICRN ACysd Cysteine CYS 25

5 PROS 5 JIYes 1 a 1ICRN A:Prob Proline PRO -16 Y
< 1l »

\Molecule /\_Cell_/\_AminoAcidChain_/\_ Amino#cid /\_Atom /\_Bond /\_Group J

RICNIBLERD 2 A THERELET .
[Simulation] Tool Set%3&RL. [Tools] Explorer® [Change Forcefield] #4 U v o L TRBBELE Y.
Forcefield & UtPartial Charge £ EL £
Z D5 TIk. Forcefield CCHARMm#%. Partial Chargel[CMomany-Rone&3&iRL 3. &#RL7=5. Apply Forcefield® 4 Vv 4 L TEALET.

P

Macromolecules B0 4001

UNew v 2 *
Tools ] | Files n

Run Simulations

Setup Constraints

Chanee Forcefield

Forcefield: CHARMm «

Partial Charge: Momany-Rone
Apply Forcefield

charmm36 Forcefield

Assign Forcefield..

JRIC. Tools Explorer®®Run Simulations% &R L+ Tools > Minimization % Y v ¥ L. Minimization¥ 4 7O/ #M&E X7,
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Macromolecules m Req

4 New v% N » X
Tooks 3 | Files [ ] n {

Run Simulations ‘ -

These tools work on a single
maolecule or complex. To minimize a
set of emall molecules independently,
use Minimize Ligands.

Tools

Calculate Enerey...
=i Clean Geometry
Minimization...

Use Standard Dynamics Cascade to
minimize, equilibrate and perform an

Parameter Name Parameter Value

Input Typed Molecule 1crn:1CRN
Minimization

Implicit Solvent Model None

Nonbond List Radius 14.0
Electrostatics Automatic
Advanced

["] Show Parameter Help
[ Run ] [OptionSV ] [ Cancel ] [ Help

BINS A—AR—DiEiAE. Helpx TEEBLEEL.

ZOFITIH T7FIMDEFRNEI Uy I LET. STEAIRIBSN. UTOD 1> RUARRENET.
Minimizine: 1CRN
] Details

\ Background] [ Stop

HE# [FJobs Explorer CHERR TE £ ¥
HENRTT2LEUTOLSICRRENETDT. OKES Yy I LET.
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BIOVIA Discovery St

Minimization
CHARMm Energy = -2260.22878. For individual energy components, see the molecule properties in the table.

[ QK H Report ]

5.2. T E#ER OHERR

SHEEZEITLTVSRE. ERIE. Setasdefault TIEEL =7 44 —IC. "Ta haLEZ _FEABR LWS 74 LA —ZTIERENET.
{ER SN T # LA —DO0utput 7 # LA — [CETERER T 7 1 LHMER S ET.

4 ) Minimization_2017_10_26_143713_457

4 &3 Input

1CRN.dsv

8@ Protocol.pr_xml
4 {3 Output

- () Report

1CRN.mol2

El| charmm.leg

| Output.log

1 Report.htm

ViewResults.ds_pl

HIERE. FRALETo baLicEYEDLYET.
ZOFITIH. FTRICRT 7 7 AINMERENET.

TrANE RE

charmm.log CHARMMIC & 25T E#ER

1CRN.mol2 MinimizationlC& > TELNIIBIET 7 1)L

Output.log FEY—/AL0aATY REZDOBREODNTEREFELETI 7ML

IS —RTLIEBRE A7 71V ESBL. MESERHELTIESY

Report.htm HEEREEDEHTMUEXO 7 7 1L

SHEERIE. Jobs Explorer SIFUNHET Z & HAIEET T .

Jobs ‘
Protocol Name Saved Status Details Elapsed Time
4 Minimization []No Success -2260.22878 kca 0:00:57

View Results
Minimized Molecule
CHARMm Log File

Report
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